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Abstract
Due to ongoing concerns with the price and availability of helium (He), 
many laboratories are looking for alternative carrier gases for their gas 
chromatography/mass spectrometry (GC/MS) methods. This application note 
describes the conversion of a typical GC/MS method for the qualitative analysis 
of flavor and fragrance compounds in essential oils from helium to hydrogen (H2 ). 
The Agilent 8890 GC coupled with the Agilent 5977C GC/MSD system were used 
with hydrogen carrier gas and a new source that has been optimized for hydrogen 
operation—the Agilent HydroInert source. Unlike most conventional electron 
ionization (EI) sources, the HydroInert source provides excellent mass spectral 
fidelity for flavor compounds when using hydrogen. To further increase confidence 
in compound identification, deconvoluted mass spectra and linear retention indexes 
(RI) from Agilent MassHunter Unknowns Analysis software were searched against 
the NIST23 mass spectral library. Using the Agilent Method Translator tool, a column 
and chromatographic conditions for hydrogen were chosen that allowed reduction 
of the analysis time by a factor of 2.5 compared to the typical helium method. By 
proper selection of instrument configuration and operating conditions, the system 
with hydrogen carrier gas can generate results comparable to those with helium, but 
with significantly reduced run time.

Qualitative Analysis of Essential Oils 
Using GC/MS with Hydrogen Carrier 
Gas and the Agilent HydroInert Source
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Introduction
Essential oils are widely used as a source of flavors and 
fragrances in both food and nonfood consumer products. 
Quality control analysis of essential oils has long been 
challenging due to the hundreds of terpenes and terpenoid 
compounds that can be present in the oils. To address this, 
methods using high-resolution capillary GC combined with 
MS have typically been employed. Searching the acquired 
mass spectra against libraries of flavor and fragrance 
compounds can be performed for identification, but is usually 
insufficient because many compounds, especially isomers, 
give similar spectra. For this reason, RIs are often used as 
a complement to spectral matching for more dependable 
identifications. The measured RI of an unknown is used in 
conjunction with the results of the spectral library search to 
determine the best candidate for identification. 

This application note describes the conversion of a typical 
GC/MS method for the qualitative analysis of flavor and 
fragrance compounds in essential oils from helium to 
hydrogen. The two methods are then applied to the analysis 
of two common essential oils—orange oil, of Brazilian origin, 
and neroli oil—for comparison. The hydrogen method was 
further evaluated using different EI source components to 
determine the optimal source for maintaining spectral fidelity.

The conversion of a method from helium to hydrogen 
carrier gas requires consideration of the chromatographic 
parameters such as column choice, column flow, amount 
injected, and temperature program rates.1 In addition, it is 
important to consider the MS parameters of column flow rate 
and MS source configuration. All these considerations and 
parameters are included in the Agilent EI GC/MS Instrument 
Helium to Hydrogen Carrier Gas Conversion User Guide.1 

When determining the chromatographic parameters for the 
hydrogen method, it is desirable to have a method that has:

	– Column dimensions that result in a high enough inlet 
pressure for accurate flow control

	– Similar chromatographic resolution to the original 
helium method

	– Maintenance of the same analyte elution order as the 
original helium method

	– Use of a column flow near the optimum for the column 
diameter used

	– Use of a column flow near the optimum for MS 
source sensitivity

The Agilent Method Translator tool2-4 is a calculator 
designed to greatly simplify this process. It was used in this 
application note.

For the MS parameters, the column flow rate should be kept 
within or near the optimum range of approximately 0.8 to 
1.4 mL/min to maximize the MS response. Another important 
consideration is the choice of MS EI source hardware. 
The concern is that some analytes undergo reactions with 
hydrogen in the source, changing their ion ratios and spectra, 
thus reducing their library match scores (LMS), and possibly 
resulting in misidentification. With the Agilent inert extractor 
source used in the Agilent 5977 series GC/MSD systems, 
this effect has been reduced in the past using an extractor 
lens with a larger diameter, such as 9 mm. However, this only 
partially addressed the problem, as many compounds such 
as nitro compounds and some terpenes and terpenoids still 
exhibited reactions. For this reason, Agilent developed the 
HydroInert source5,6, which greatly reduces or eliminates 
these reactions. To evaluate the effectiveness of the 
HydroInert source, the qualitative analysis of the two oils was 
carried out with the helium method using the standard 3 mm 
inert extractor source and the hydrogen method using the 
standard HydroInert source, which is equipped by default with 
the 9 mm lens. In addition, the oils were analyzed with the 
hydrogen method and a conventional inert extractor source 
using both the 3 and 9 mm extractor lenses for comparison.

The next consideration is how to process the data files to 
obtain the mass spectrum of each oil component and search 
it against a library. In the past, this was done largely by 
obtaining the apex or average spectrum over the peak then 
subtracting a baseline spectrum taken next to the peak. The 
resulting spectrum was then searched against the spectral 
library. While this process is effective for handling a few peaks 
that were relatively well resolved, it becomes overwhelming 
with large numbers of peaks and/or overlapping peaks. 

Fortunately, there is now a powerful solution for mass 
spectral identification called Agilent MassHunter Unknowns 
Analysis (MHUA), which is part of the Agilent MassHunter 
Quantitative Analysis software suite. MHUA uses spectral 
deconvolution to extract clean analyte spectra from the 
complex overlapping peaks. The deconvolution and library 
search processes are automated and take approximately 1 to 
8 minutes per data file depending on the file size, library size, 
computer hardware, and so on. The result is cleaner spectra 
than with the previous approach, which therefore results in 
higher LMS and greater confidence in peak identifications.7 

https://www.agilent.com/cs/library/usermanuals/public/user-guide-coverting-ei-gcms-instruments-5994-2312en-agilent.pdf
https://www.agilent.com/cs/library/usermanuals/public/user-guide-coverting-ei-gcms-instruments-5994-2312en-agilent.pdf
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A second major feature of MHUA is the ability to calculate the 
RI for each peak. If the searched library has the appropriate 
reference RI values associated with spectral entries, the 
measured RI value for an unknown spectrum can be used to 
filter the spectral search results. This is especially important 
in the identification of essential oil components because of 
spectral similarities. RI values were used in this application 
note for this reason. 

There are multiple mass spectral libraries available with RIs 
for flavor and fragrance compounds. For example, the Adams 
library8 has been used widely for many years for this analysis. 
Recently, NIST released a newer version of their mass spectral 
library (NIST23), which has numerous enhancements. Among 
them are the incorporation of the entire Adams library and 
the expansion of semistandard, nonpolar RI entries to cover 
all EI spectra. "Semistandard, nonpolar" refers to phases such 
as HP-5, DB-5, HP-5ms, and other 5% phenylmethyl silicone 
phases.9 The new RI values are either experimental values, if 
available, or artificial intelligence (AI)-generated values. Note 
that the AI-generated values have better accuracy than the 
previous "estimated" values. The new semistandard, nonpolar 
values are of specific interest here because this type of 
stationary phase is commonly used in essential oil analysis 
with GC/MS. Also, these are the NIST23 values currently 
usable with the RI function in MHUA. When the RI function of 
MHUA is used, the experimental semistandard, nonpolar RI 
values are used if available; if not, the AI-generated values are 
used. Therefore, NIST23 is the library used here.

Experimental

Column selection
For the reference helium method, the column and conditions 
chosen are like those frequently used in the past.8,10 
A 30 m × 0.25 mm id, 0.25 μm Agilent J&W HP-5ms Ultra Inert 
(UI) column (part number 19091S-433UI) was used with an 
oven temperature program from 60 to 240 °C at 3 °C/min. 
Although some of the older methods10 used constant 
pressure control mode for column flow, constant flow mode 
is far better in terms of MS performance. A constant column 
flow rate of 1.0 mL/min of helium was used. 

For the hydrogen method, a 20 m × 0.18 mm id, 0.18 μm 
Agilent J&W HP-5ms UI column (part number 19091S-577UI) 
was chosen. This column makes an excellent choice for 
several reasons:

	– The column dimensions provide an inlet pressure with 
hydrogen that is high enough for accurate flow control.

	– The column provides similar or better chromatographic 
resolution compared to the helium method.

	– The phase ratio is the same, helping maintain the same 
analyte elution order as the original method.

	– A column flow of hydrogen near the optimum for both 
chromatographic separation and MS source sensitivity 
can be used. 

Method translation
The Method Translator tool is included as part of the Agilent 
MassHunter acquisition software or can be downloaded 
for standalone use from Agilent.com: https://www.agilent.
com/en/support/gas-chromatography/gccalculators. 
The free download includes the Method Translator, Vapor 
Volume Calculator, Pressure Flow Calculator, and Solvent 
Vent Calculator tools, which are all useful when developing 
GC methods.

After installation, the Method Translator is opened from 
an icon on the desktop. The opened Method Translator is 
shown in Figure 1. First, the chromatographic parameters 
of the original helium method are entered in the left column 
labeled Original Method Parameters. The carrier gas type 
(He), column dimensions, column outlet pressure, and oven 
temperature program ramp should be entered first. The 
column outlet flow is then entered. As shown in Figure 1, the 
other values such as phase ratio, inlet pressure, and so on, are 
calculated automatically. 

Next, the carrier gas type (H2 ), column dimensions, and 
column outlet pressure for the hydrogen method are entered 
in the right side of the calculator under the Calculated Method 
Parameters column.

After entry, the calculated hydrogen parameters are displayed. 
In the upper-left corner, the calculated speed gain is shown 
as 2.5877, meaning that the predicted retention times (RTs) 
with the hydrogen method would be a factor of approximately 
2.6 smaller than the helium method. The calculated oven 

https://www.agilent.com/en/support/gas-chromatography/gccalculators
https://www.agilent.com/en/support/gas-chromatography/gccalculators
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ramp rate for hydrogen would be 7.763 °C/min. Note that it 
would be easier to have the oven ramp rate and the speed 
gain closer to 7.5 and 2.5, respectively. This can be done 
by selecting Speed gain and entering 2.5 into the field. 
The parameters are recalculated, resulting in the desired 
parameters. Figure 1 shows the results. Note that the 
calculated flow for the hydrogen method shown in Figure 1 
is 0.84004 mL/min. Before using the method, retention time 

locking (RTL) was used to make the RT of n-pentadecane 
in the hydrogen method precisely 2.5 times faster than that 
with the helium method. This made comparison of RTs 
easier. The resulting flow for the hydrogen method after 
RTL was 0.958 mL/min. For library searching, this step is 
not necessary as the RI calibration accounts for differences 
in flow. 

Figure 1. Agilent Method Translator tool, used to determine method parameters for conversion of the helium method to hydrogen.
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MS source hardware
The standard inert extractor source with the 3 mm extractor 
lens is an excellent choice for the helium method when 
analyzing flavor and fragrance compounds, and was used in 
this application note. For the hydrogen method, the HydroInert 
source with the 9 mm extractor lens was used, as it reduces 
in-source reactions with hydrogen and provides improved 
peak shape. The hydrogen method was also run with a 
conventional inert extractor source using both the 3 and 9 
mm extractor lenses. These data were compared to that from 
the HydroInert and helium results to identify components of 
the oils that were most susceptible to in‑source reactions by 
comparing their spectra and LMS values. Figure 2 shows the 
system configurations for the helium and hydrogen methods.

Chemicals and standards
In-house hydrogen with 99.9999% purity specification and 
low individual specifications on water and oxygen was used 
as the carrier gas for the hydrogen method. In-house helium 
with similar specifications was used as the carrier gas for the 
helium method.

Cold-pressed orange oil (Brazil origin) and neroli oil (Morocco 
origin) were purchased from Sigma-Aldrich (Milwaukee, WI, 
USA). The oils were diluted to 20:1 (v:v) in ethanol. 

A custom RI calibration standard consisting of all the 
n-alkanes from n-C5 to n-C40 plus n-C44 was purchased 
from Ultra Scientific (now Agilent). All alkanes were at a 
concentration of 500 ng/µL in n-hexane except n-C13, n-C18, 
n-C22, n-C28, n-C31, and n-C39, which were at 1,000 ng/µL. The 
standard was then diluted to 50:1 (v:v) in isooctane. 

Figure 2. System configurations for the helium and hydrogen methods.

Liquid
injector

S/SL Inlet
(hydrogen)

HydroInert source 
with 9 mm 

extractor lens

EI source

20 m × 180 µm, 0.18 µm df  

Agilent 8890 
GC

Agilent 8890 
GC

Liquid
injector

S/SL inlet
(helium)

Inert extractor 
with 3 mm 

extractor lens

Agilent 5977C
GC/MSD

Agilent 5977C
GC/MSD

EI source

30 m × 250 µm, 0.25 µm df  
Agilent HP-5ms UI Agilent HP-5ms UI 

Helium configuration Hydrogen configuration

Table 1. GC and MS conditions for helium and hydrogen methods.

Method Parameters

Helium Method Hydrogen Method

Inlet EPC split/splitless

Mode Split 25:1

Column Flow 1.0 mL/min helium 0.958 mL/min hydrogen

Injection Volume 1.0 µL

Inlet Temperature 250 °C

Inlet Liner Agilent universal low pressure drop UI liner with wool 
(p/n 5190-2295)

Column
Agilent J&W HP-5ms UI,  

30 m × 0.25 mm, 0.25 µm 
(p/n 19091S-433UI)

Agilent J&W HP-5ms UI,  
20 m × 0.18 mm, 0.18 µm 

(p/n 19091S-577UI)

Column Temperature 
Program

60 °C (no hold) 
3 °C/min to 240 °C  

(no hold)

60 °C (no hold) 
7.5 °C/min to 240 °C  

(no hold)

Run Time 60 min 24 min

MSD Source Agilent inert extractor  
(3 mm lens)

Agilent HydroInert source 
(9 mm lens)

Transfer Line 
Temperature

300 °C

Ion Source 
Temperature

300 °C

Quadrupole 
Temperature

150 °C

EM, Gain Mode 0.1

Mode Scan 40 to 400 m/z

TID, A/D Samples TID ON, 8 TID ON, 4

Solvent Delay 2.2 min 0.88 min

Tune etune.u
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Results and discussion

Retention index calibration
The diluted RI calibration standard was run with both 
methods. The chromatograms are shown in Figure 3. 
Although the oil sample analysis is finished before n-C26, 
the standard contains n-alkanes up to n-C40. Therefore, the 
temperature ramps for both RI calibration methods were 
extended to 300 °C and held until n-C40 eluted to prevent 
carryover peaks in subsequent chromatograms. The red 
arrow in each chromatogram indicates the normal end of 
run for the oil methods. For determining the RT of the RI 
calibration compounds, integrating the EIC for m/z 57 is 
preferred over the total ion chromatogram (TIC), as it has a 
better signal-to-noise ratio. 

To use RI values in MHUA, a calibration file needs to be 
created for each method. The file can be created as a .csv 
file in Microsoft Excel, or as a text file in Microsoft Windows 
Notepad. Figure 4 shows the calibration .rtc files created in 
Notepad. The blue headers are not included in the files; they 
are included here to indicate the entry format. Each entry 
consists of the format name, CAS number, RI, and RT, and the 
associated text file is then saved with a .rtc extension in the 
filename. The text files are usually saved in either the library 
directory or the directory containing the data files. 

Figure 3. EICs at m/z 57 for the RI calibration standard. (A) Helium method; (B) hydrogen method. 
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Brazilian orange oil
Figure 5 compares the TICs obtained with the helium and 
hydrogen methods for the Brazilian orange oil sample. 
Figure 5A shows the complete time range of elution, and 
5B is an expanded view to better compare the peak shapes 
and chromatographic resolution. As can be seen, by using 
the Method Translator technique, the relative elution order 

of peaks is maintained, as is the resolution. Many of the 
larger peaks in the hydrogen chromatogram exhibited some 
fronting. This was predicted by the Method Translator tool, 
which indicated that the hydrogen setup has 36% of the 
original column capacity of the helium method. However, the 
chromatographic resolution is still about the same as the 
helium method. 

Figure 4. RI calibration text files (.rtc) used in Agilent MassHunter Unknowns Analysis. 

Helium method

Name,  CAS,                RI,      RT

Hydrogen method

Name,  CAS,                RI,      RT
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Figure 5. (A) Brazilian orange oil with helium and hydrogen methods showing full range of compound elution. (B) Expanded view of earlier elution time region.
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Neroli oil
Figure 6 shows the TICs for the neroli oil run with the helium 
and hydrogen methods. As with the orange oil, the relative 
elution order of peaks is maintained, as is the resolution. The 
reduced column capacity of the hydrogen method is again 
evident in the increased fronting of the large peak at 4.6 
minutes in the hydrogen chromatogram.

Peak identification with MassHunter Unknowns Analysis
The parameters used with MHUA are listed in Table 2. If the 
library has appropriate RI values for the spectrum entries, RIs 
can be used as a filter for library hits. The program uses RI if 
an RI calibration filename is entered in the RT calibration file 
box. A more detailed description for setting up and running an 
analysis is shown in the Appendix. Also, an excellent source 
of information about MHUA is available in a video on the 
Agilent YouTube channel.7 

With the settings listed in Table 2 and a data file analyzed, the 
program will deconvolute the entire scan file and determine 
where each detectable peak (component) is. It will then take 
the deconvoluted (cleaned) spectrum of each component and 
search it against the library (NIST23). The library entry that 
best matches the spectrum of the component is checked to 
see if it exceeds the minimum match factor parameter of 70. 
If it does, it is next checked to see if the measured RI of the 
component falls within ± the penalty free range, in this case 
± 10 seconds. With the RT mismatch penalty set to Additive 
and the maximum RT penalty set to 100, if the difference 
between the measured RT and the library RI (converted to RT) 
is greater than 10 seconds, the entry is completely discarded. 
If the difference is less than 10 seconds and the LMS is 
greater than 70 and higher than the other possible hits, the hit 
is included in the results table. 

Figure 6. Neroli oil analyzed with (A) helium and (B) hydrogen methods. 
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Table 2. Agilent MassHunter Unknowns Analysis method parameters.

Parameter Setting

RT Window Size Factor 10, 25, 50, 100, 200, 400, 600, 800

Library NIST23.L

RT Penalty function Trapezoidal

 RT Range 10 s

 Penalty Free Range 10 s

RT Mismatch Penalty Additive

 Maximum RT Penalty 100

Minimum Match Factor 70

Once the entire data file has been processed, the results 
can be reviewed. Figure 7 shows the results for the Brazilian 
orange oil with the helium method. Left-clicking on the 
compound name for one of the listed results displays the 
deconvoluted component spectrum head to tail with the 
library spectrum.

Figure 7. Agilent MassHunter Unknowns Analysis results for Brazilian orange oil run with the helium method. 

Identification results

TIC chromatogram

Component spectrum

NIST 23 library spectrum

The selected component peak at 16.989 minutes is 
highlighted in red in the TIC chromatogram, which can be 
zoomed in for closer inspection. The five most abundant 
ions are extracted and overlaid in the box to the left of 
the spectrum display. This is to allow inspection of the 
peak shapes and apex retention times. If the apex RT or 
shape of one of the extracted ions is substantially different 
from the others, this suggests that there might be an 
interference, which should be considered when interpreting 
the identification. 

In practice, reviewing the results consists of going down the 
list of hits and looking at the Match Factor (Library Match 
Score), Delta RI, and Base Peak Area. Using the peak at 
16.989 as an example, the spectrum has a high-quality match 
for D-carvone of 98.2 listed, and the head-tail component and 
library spectra visually match well. The overlay of EICs of the 
principal ions all have the same shape and apex RT. The delta 
RI value of 2, which is the difference between the measured 
RI for the peak and that from the library, is small at 2. Finally, 
the base peak area and observed peak size in the TIC 
chromatogram indicate that the response is large enough to 
produce good-quality spectra. From these observations, the 
identification of D-carvone is confirmed with high confidence. 
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In contrast, the peak at 17.6172, identified as 
p-mentha-1(7),8(10)-dien-9-ol, has a low LMS of 74.6, a 
larger delta RI of 4, one of the EICs has a noticeably different 
apex RT, and the base peak area is small—approximately 
190 times smaller than the D-carvone peak. This would be 
a low‑confidence identification. If the reviewer decides it 
should not be reported, the hit can be removed from the 
results by right-clicking the name and selecting Delete 
Components/Hits.

If an identification is questioned based on other information, 
the reviewer can right-click the name in the results table and 
select Show Alternate Hits. This will display a list of the other 
spectra in the library that also met the LMS and RI criteria, 
but with an LMS less than the listed Best Hit. This is useful 
as sometimes the LMS of the lesser hits is only a fraction of 
a point smaller. If desired, the reviewer can select one of the 
alternate hits and set it as the identification. 

This review process is used to evaluate all the hits. Once 
completed, the reviewed analysis can be saved and a report 
can be generated if desired.

Evaluating in-source reactions with hydrogen 
While the inert extractor source with the 3 mm lens is 
standard for use with helium, it is not the source of choice 
for use with hydrogen carrier. The metal surfaces inside the 
source tend to catalyze reactions between hydrogen and 
some analyte molecules in the source, resulting in peak 
tailing and spectral changes for some compounds. In the 
past, substituting the 9 mm extractor lens for the 3 mm lens 
was used as it reduced the tailing and spectral changes to 
some degree, but did not eliminate them. For this reason, the 
HydroInert source was developed. 

In this section, the spectra of carvone oxide (CAS number 
33204-74-9) obtained with hydrogen using the HydroInert 
source, the inert extractor source with the 3 and 9 mm lenses, 
and with helium are compared to illustrate the effects of 
source reactivity. Several other examples are presented in 
the Appendix.

Figure 8 shows the chromatograms and spectra of 
the carvone oxide peak with the helium and hydrogen 
methods under the optimized conditions. The library 
reference spectrum from NIST23 is shown upside down for 
comparison. With both methods, the deconvoluted spectra 
have high LMS values of > 95, demonstrating the excellent 
spectral fidelity provided by the HydroInert source with 
hydrogen carrier gas. 

Figure 8. (A) Chromatogram and spectrum of the carvone oxide peak with the helium method. (B) Chromatogram and spectrum of the carvone oxide peak with 
the hydrogen method and Agilent HydroInert source. 
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For comparison, Figure 9 shows the spectra of the carvone 
oxide peak with hydrogen carrier using the HydroInert source 
and the inert extractor source with both the 9 and 3 mm 
extractor lenses. 

With the 9 mm inert extractor lens shown in the spectrum in 
Figure 9B, the LMS value is still a respectable 91.2. However, 
there is clear evidence of some spectral changes. Most 
notably, the ions 82 and 108 have increased in abundance 
relative to the rest of the ions in the spectrum. While the 
degree of spectral fidelity is still useful, it demonstrates that 
in-source reactions, albeit limited, are occurring.

In contrast, the spectrum with the 3 mm inert extractor 
lens and hydrogen carrier is significantly changed. The 
spectrum is changed to the extent that the LMS for matching 
carvone oxide is below the 70 cutoff and thus is not listed, 
even in the alternate hits list. The search identified the peak 
as (2,6,6-trimethylbicyclo[3.1.1]heptan-3-yl)methanamine 
(CAS 61299-72-7), also known as pinane-3-(methylamine). 
Note that with an LMS value of 84.8 and a close RI match 
with a delta RI of only –1, this identification looks plausible 
but is incorrect.
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Figure 9. (A) Spectrum of the carvone oxide with hydrogen carrier and the 
Agilent HydroInert source. The reference spectrum is carvone oxide from 
NIST23. (B) Spectrum with an Agilent inert extractor source and a 9 mm 
lens. The reference spectrum is carvone oxide from NIST23. (C) Spectrum 
with an Agilent inert extractor source and a 3 mm lens. The reference 
spectrum is (2,6,6-trimethylbicyclo[3.1.1]heptan-3-yl)methanamine 
from NIST23.
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To further investigate the nature of the in-source reaction with 
the 3 mm inert extractor source, the data file was reanalyzed 
with MHUA using the same parameters, except not using the 
RI match criteria. This would list the best hits solely on LMS. 
If the carvone oxide is reacting with hydrogen in the source 
to produce a reaction product, the spectral search may reveal 
what it is. Figure 10 shows the spectrum obtained with (A) the 
3 mm lens at the carvone oxide RT compared with (B) that of 
the best match and (C) the carvone oxide library spectrum. 

Note that the spectrum obtained with the 3 mm inert 
extractor source looks very much like a combination of that 
of carvone oxide and 3-hydroxy-2-methyl-5-(prop-1-en-2-yl)
cyclohexanone. Examining the structures in Figure 10, it 
appears that the epoxide structure of carvone oxide reacts 
with hydrogen to form the OH group.

This example clearly illustrates the perils of using a GC/MS 
source that allows reactions between hydrogen and analytes, 
and why the HydroInert source is the best choice when using 
hydrogen carrier gas. Several other examples are shown in 
the Appendix.

Figure 10. (A) Spectrum obtained with the 3 mm lens at the carvone oxide RT. (B) NIST23 library reference spectrum for the best match when searched without RI 
filtering, 3-hydroxy-2-methyl-5-(prop-1-en-2-yl)cyclohexanone. (C) NIST23 library reference spectrum for carvone oxide.
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Analysis results for Brazilian orange and neroli oils
Table 3 presents the results of the analysis of the Brazilian 
orange oil with both the helium method using the 3 mm inert 
extractor source and the hydrogen method using the 9 mm 
HydroInert source. Table 4 presents the results for neroli oil 
with the same methods. 

The results were reviewed to address questions relevant to 
converting the method helium to hydrogen carrier gas:

	– RIs compared to NIST23: The RIs measured with both 
methods closely matched those in the NIST23 library for 
most compounds. However, it should be recognized that 
the RI recognition window used in MassHunter Unknowns 
Analysis limits the maximum delta RI when listing hits. The 
second consideration is that if the NIST23 RI value is an 
AI-predicted value instead of a true experimental value, the 
errors, and thus the delta RIs, can be larger. 

	– Comparing RIs between helium and hydrogen methods: 
As seen in the columns listing the difference between the 
RI measured with helium and that with hydrogen (labeled 
RI He-RI H2 ), the agreement of the RIs measured with 
both methods is good. The only exceptions are the earliest 
peaks and those such as linalool and D-limonene that are 
chromatographically overloaded, thus shifting their RT. 
This is one of the benefits of using the Method Translator 
tool to choose the chromatographic parameters for the 
hydrogen method, because it maintains the same relative 
elution order for analytes and RI calibrators between the 
two methods.

	– LMS versus NIST23: The deconvolution process in general 
yields cleaner spectra, which results in improved LMS 
scores when compared to previous approaches. Looking 
at the column of LMS scores for the helium results, 
most of them are > 85. The smaller values can result 
from smaller responding compounds, overlapping peaks 
causing spectral interferences, or search results where the 
analyte is not in the library and an incorrect hit is listed.

	– Comparing LMS between helium and hydrogen methods: 
The columns listing the difference between the LMS 
measured with helium and that with hydrogen (labeled 
LMS He-LMS H2 ) shows that, in general, there is good 
agreement between the two methods. The exceptions 
where the hydrogen method values are significantly 
lower are either due to lower signal response or spectral 
interference from overlapping peaks. In general, the 
signal-to-noise ratios obtained with hydrogen are two to 
five times less than with helium, and this is reflected in 
lower LMS scores for the smallest peaks. 
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Table 3. Analysis results for the Brazilian orange oil with both the helium and hydrogen methods. (LR = low response; Int = interference.)

Compound Name CAS Lib RI

Helium Hydrogen with Hydroinert RI He- 
RI H2

LMS He- 
LMS H2RT RI Delta RI LMS RT RI Delta RI LMS

Ethane, 1,1-diethoxy- 105-57-7 726 2.445 723 3 98 1.061 732 -6 96 -9 2

Nonane 111-84-2 900 4.807 900 0 95 1.983 900 0 91 0 4

(1R)-2,6,6-Trimethylbicyclo[3.1.1]hept-2-ene 7785-70-8 932 5.688 933 -1 99 2.332 933 -1 97 0 2

1-Heptanol 111-70-6 970 6.566 966 4 98 2.699 968 2 95 -2 2

Bicyclo[3.1.0]hexane, 4-methylene-1-(1-methylethyl)- 3387-41-5 974 6.757 973 1 98 2.759 974 0 98 -1 0

beta-Myrcene 123-35-3 991 7.240 991 0 97 2.953 992 -1 95 -1 2

Octanal 124-13-0 1,003 7.616 1,004 -1 98 3.116 1,006 -3 97 -2 1

3-Carene 13466-78-9 1,011 7.883 1,011 0 98 3.211 1,012 -1 89 -1 9

D-Limonene 5989-27-5 1,031 8.682 1,034 -3 99 3.562 1,037 -6 99 -3 0

1-Methylbicyclo[2.2.1]heptan-exo-2-ol 766-25-6 1,039 8.796 1,037 2 76 3.593 1,039 0 74 -2 2

trans-Sabinene hydrate 17699-16-0 1,070 9.837 1,066 4 74 3.985 1,067 3 77 -1 -3

1-Octanol 111-87-5 1,070 9.919 1,068 2 98 4.016 1,070 0 97 -2 1

cis-Linalool oxide 5989-33-3 1,074 10.039 1,072 2 94 4.063 1,073 1 94 -1 0

trans-Linalool oxide (furanoid) 34995-77-2 1,086 10.630 1,088 -2 95 4.297 1,089 -3 94 -1 0

Benzene, 1-methyl-4-(1-methylethenyl)- 1195-32-0 1,090 10.665 1,089 1 91 4.306 1,090 0 92 -1 -1

Epoxymyrcene,6,7- 29414-55-9 1,090 10.804 1,093 -3 73 4.365 1,094 -4 79 -1 -6

Linalool 78-70-6 1,099 11.051 1,100 -1 97 4.462 1,101 -2 95 -1 1

Nonanal 124-19-6 1,104 11.232 1,104 0 96 4.533 1,105 -1 86 -1 10 LR

cis-Pinen-3-ol 1010292-85-2 1,108 11.324 1,107 1 81 4.574 1,108 0 73 -1 8

2-Cyclohexen-1-ol, 1-methyl-4-(1-methylethenyl)-, 
trans-

7212-40-0 1,123 11.872 1,120 3 95 4.799 1,122 1 96 -2 -1

5-Undecene, 4-methyl- 143185-91-5 1,132 12.217 1,129 3 74 4.925 1,130 2 71 -1 4

7-Oxabicyclo[4.1.0]heptane,  
1-methyl-4-(1-methylethenyl)-

1195-92-2 1,133 12.401 1,133 0 86 5.003 1,134 -1 90 -1 -4

cis-p-Mentha-2,8-dien-1-ol 3886-78-0 1,133 12.462 1,135 -2 79 5.042 1,137 -4 89 -2 -10

(+)-(E)-Limonene oxide 6909-30-4 1,139 12.586 1,138 1 97 5.082 1,139 0 98 -1 -1

Cyclohexanol, 1-methyl-4-(1-methylethenyl)-, cis- 7299-41-4 1,144 12.826 1,143 1 95 5.171 1,145 -1 93 -2 1

Cyclohexanol, 1-methyl-4-(1-methylethenyl)-, trans- 7299-40-3 1,161 13.610 1,163 -2 88 5.480 1,164 -3 83 -1 4

Bicyclo[3.3.0]octan-2-one, 7-methylene- 1000151-92-1 1,166 13.822 1,168 -2 84 5.578 1,170 -4 64 -2 19 Int

1-Nonanol 143-08-8 1,173 13.921 1,170 3 98 5.603 1,171 2 96 -1 2

Ethanone, 1-(4-methylphenyl)- 122-00-9 1,183 14.452 1,183 0 93 5.822 1,185 -2 95 -2 -2

p-Mentha-1(7),8-dien-2-ol 35907-10-9 1,186 14.596 1,187 -1 97 5.873 1,188 -2 96 -1 1

alpha-Terpineol 98-55-5 1,189 14.730 1,190 -1 95 5.928 1,191 -2 94 -1 1

Bicyclo[3.1.1]hept-2-ene-2-methanol, 6,6-dimethyl- 515-00-4 1,195 14.966 1,196 -1 84 6.018 1,197 -2 86 -1 -2

Decanal 112-31-2 1,206 15.374 1,206 0 94 6.173 1,206 0 93 0 1

Acetic acid, octyl ester 112-14-1 1,210 15.663 1,212 -2 91 6.287 1,213 -3 79 -1 12 LR, Int

Dihydro carveol, iso- 18675-35-9 1,212 15.756 1,215 -3 85 6.334 1,216 -4 78 -1 7

trans-Carveol 1197-07-5 1,217 15.946 1,219 -2 95 6.427 1,221 -4 96 -2 -1

trans-3(10)-Caren-2-ol 1010151-66-5 1,227 16.281 1,227 0 89 6.550 1,229 -2 85 -2 4

2-Cyclohexen-1-ol, 2-methyl-5-(1-methylethenyl)-, cis- 1197-06-4 1,229 16.423 1,230 -1 96 6.616 1,232 -3 97 -2 -1

2,4-Cycloheptadien-1-one, 2,6,6-trimethyl- 503-93-5 1,238 16.606 1,235 3 81 6.693 1,237 1 73 -2 8

Benzaldehyde, 4-(1-methylethyl)- 122-03-2 1,239 16.796 1,239 0 73 6.753 1,241 -2 58 -2 14 LR

D-Carvone 2244-16-8 1,246 16.989 1,244 2 98 6.842 1,246 0 98 -2 0

Geraniol 106-24-1 1,255 17.486 1,255 0 72 7.026 1,257 -2 77 -2 -5

p-Mentha-1(7),8(10)-dien-9-ol 29548-13-8 1,262 17.617 1,258 4 75 7.070 1,259 3 73 -1 2
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Compound Name CAS Lib RI

Helium Hydrogen with Hydroinert RI He- 
RI H2

LMS He- 
LMS H2RT RI Delta RI LMS RT RI Delta RI LMS

4-Cyclohexylidenebutyraldehyde 937-59-7 1,268 17.871 1,264 4 75 7.178 1,266 2 76 -2 -2

2-Cyclohexen-1-one, 3-methyl-6-(1-methylethenyl)-, 
(S)-

16750-82-6 1,270 18.140 1,271 -1 91 7.290 1,272 -2 83 -1 7

1-Cyclohexene-1-carboxaldehyde, 
4-(1-methylethenyl)-

2111-75-3 1,273 18.233 1,273 0 97 7.320 1,274 -1 84 -1 14 LR

Carvone oxide 33204-74-9 1,279 18.430 1,278 1 96 7.400 1,279 0 96 -1 0

Pinocarvyl acetate, cis- 73366-18-4 1,285 18.757 1,285 0 80 7.523 1,286 -1 82 -1 -2

Verbenyl acetate, trans- 1203-21-0 1,291 18.907 1,289 2 79 7.588 1,290 1 80 -1 0

p-Mentha-1,8-dien-7-ol 536-59-4 1,297 19.266 1,297 0 95 7.731 1,298 -1 93 -1 2

2-Propanol, 1-[(1-ethynylcyclohexyl)oxy]- 54644-17-6 1,303 19.534 1,304 -1 77 7.842 1,305 -2 79 -1 -1

1,2-Cyclohexanediol, 1-methyl-4-(1-methylethenyl)- 1946-00-5 1,321 20.266 1,321 0 80 8.134 1,323 -2 84 -2 -4

(1S,4R,5R)-1,3,3-Trimethyl-2-oxabicyclo[2.2.2]octan-
5-yl acetate

81781-24-0 1,343 21.019 1,339 4 83 8.459 1,342 1 82 -3 1

exo-2-Hydroxycineole acetate 57709-95-2 1,344 21.273 1,345 -1 86 8.549 1,347 -3 89 -2 -2

1-Cyclohexene-1-methanol, 4-(1-methylethenyl)-, 
formate

29621-55-4 1,356 21.612 1,353 3 87 8.664 1,354 2 90 -1 -4

2-Cyclohexen-1-ol, 2-methyl-5-(1-methylethenyl)-, 
acetate, (1R-cis)-

7111-29-7 1,358 21.856 1,359 -1 80 8.775 1,361 -3 79 -2 1

Copaene 3856-25-5 1,376 22.546 1,375 1 91 9.024 1,376 0 84 -1 6

2-Methyl-4-(2,6,6-trimethylcyclohex-2-enyl)but-3-en-
2-ol

56763-65-6 1,406 23.737 1,404 2 83 9.528 1,406 0 85 -2 -2

cis-β-Copaene 18252-44-3 1,432 24.728 1,428 4 93 9.897 1,429 3 89 -1 3

Sesquicineole, 7-epi-1,2-dehydro- 149067-90-3 1,471 26.498 1,472 -1 78 10.618 1,473 -2 79 -1 -1

3-Tetradecen-5-yne, (E)- 74744-44-8 1,488 27.032 1,485 3 72 10.842 1,487 1 73 -2 -1

Valencene 4630-07-3 1,492 27.311 1,492 0 97 10.930 1,493 -1 96 -1 0

Caryophyllene oxide 1139-30-6 1,581 30.784 1,582 -1 73 12.320 1,582 -1 81 0 -7

1,5,9-Cyclododecanetriol 2938-55-8 2,007 45.413 2,005 2 72 18.190 2,006 1 76 -1 -4

3-Eicosyne 61886-66-6 2,032 46.366 2,036 -4 75 18.573 2,037 -5 76 -1 -2

Uvidin C, diacetate 1000501-90-0 2,107 48.516 2,107 0 75 19.432 2,107 0 73 0 2

(9E,11E)-Octadecadienoic acid 544-71-8 2,237 52.406 2,241 -4 74 20.997 2,241 -4 73 0 2

Incensole oxide, acetate 1000513-23-1 2,270 53.383 2,275 -5 72 21.395 2,276 -6 69 -1 3
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Compound Name CAS Lib RI

Helium Hydrogen with Hydroinert RI He- 
RI H2

LMS He-
LMS H2RT RI Delta RI LMS RT RI Delta RI LMS

Ethane, 1,1-diethoxy- 105-57-7 726 2.445 723 3 98 1.060 732 -6 97 -9 1

3-Hexen-1-ol 544-12-7 856 3.982 851 5 93 1.685 856 0 80 -5 13 LR

1-Hexanol 111-27-3 868 4.184 863 5 95 1.762 867 1 92 -4 3

Bicyclo[3.1.0]hex-2-ene, 2-methyl-5-(1-
methylethyl)-

2867-05-2 929 5.501 926 3 98 2.258 926 3 92 0 6

(1R)-2,6,6-Trimethylbicyclo[3.1.1]hept-2-ene 7785-70-8 932 5.688 933 -1 98 2.334 933 -1 98 0 1

Camphene 79-92-5 952 6.087 948 4 98 2.496 949 3 97 -1 1

Benzaldehyde 100-52-7 962 6.380 959 3 98 2.628 961 1 96 -2 2

Bicyclo[3.1.1]heptane, 6,6-dimethyl-2-
methylene-, (1S)-

18172-67-3 978 6.899 978 0 97 2.824 980 -2 98 -2 0

m-Mentha-4,8-diene, (1S,3S)-(+)- 5208-51-5 983 7.047 984 -1 82 2.875 985 -2 77 -1 5

beta-Myrcene 123-35-3 991 7.240 991 0 97 2.952 992 -1 97 -1 0

Cyclohexane, 1-methylene-4-(1-methylethenyl)- 499-97-8 1,004 7.667 1,005 -1 98 3.121 1,006 -2 97 -1 1

cis-Anhydrolinalool oxide 54750-69-5 1,007 7.775 1,008 -1 93 3.166 1,009 -2 79 -1 14 LR, Int

3-Carene 13466-78-9 1,011 7.874 1,011 0 97 3.203 1,012 -1 97 -1 1

1,3-Cyclohexadiene, 1-methyl-4-(1-methylethyl)- 99-86-5 1,017 8.082 1,017 0 97 3.285 1,018 -1 97 -1 0

D-Limonene 5989-27-5 1,031 8.536 1,029 2 99 3.476 1,031 0 99 -2 0

1,3,6-Octatriene, 3,7-dimethyl-, (Z)- 3338-55-4 1,038 8.782 1,036 2 97 3.562 1,037 1 97 -1 0

trans-beta-Ocimene 3779-61-1 1,049 9.174 1,047 2 97 3.724 1,049 0 97 -2 0

gamma-Terpinene 99-85-4 1,060 9.540 1,058 2 99 3.860 1,058 2 99 0 0

trans-Sabinene hydrate 17699-16-0 1,070 9.843 1,066 4 90 3.994 1,068 2 81 -2 9

cis-Linalool oxide 5989-33-3 1,074 10.047 1,072 2 98 4.071 1,073 1 96 -1 2

1,4-Undecadiene, (Z)- 55976-14-2 1,080 10.241 1,077 3 81 4.138 1,078 2 80 -1 1

Cyclohexene, 1-methyl-4-(1-methylethylidene)- 586-62-9 1,088 10.638 1,088 0 98 4.294 1,089 -1 98 -1 0

Linalool 78-70-6 1,099 11.285 1,106 -7 98 4.618 1,111 -12 98 -5 0

Phenylethyl alcohol 60-12-8 1,116 11.611 1,114 2 98 4.725 1,117 -1 96 -3 1

2-Cyclohexen-1-ol, 1-methyl-4-(1-methylethyl)-, 
cis-

29803-82-5 1,122 11.938 1,122 0 93 4.837 1,124 -2 93 -2 0

2,4,6-Octatriene, 2,6-dimethyl-, (E,Z)- 7216-56-0 1,131 12.231 1,129 2 99 4.935 1,130 1 99 -1 0

2-Isopropylimidazole 36947-68-9 1,132 12.318 1,131 1 71 4.973 1,132 0 70 -1 1

cis-p-Mentha-2,8-dien-1-ol 3886-78-0 1,133 12.460 1,134 -1 83 5.029 1,136 -3 82 -2 1

Benzyl nitrile 140-29-4 1,144 12.594 1,138 6 98 5.095 1,140 4 94 -2 5

Myroxide 28977-57-3 1,140 12.747 1,142 -2 92 5.144 1,143 -3 71 -1 20 LR, Int

Terpinen-4-ol 562-74-3 1,177 14.182 1,177 0 96 5.709 1,178 -1 96 -1 1

Benzenemethanol, alpha,alpha,4-trimethyl- 1197-01-9 1,183 14.515 1,185 -2 91 5.864 1,187 -4 90 -2 1

alpha-Terpineol 98-55-5 1,189 14.790 1,192 -3 99 5.972 1,194 -5 99 -2 0

1,3-Cyclohexadiene-1-carboxaldehyde, 
2,6,6-trimethyl-

116-26-7 1,201 15.153 1,200 1 78 6.099 1,202 -1 79 -2 -2

(3E,5E)-2,6-Dimethylocta-3,5,7-trien-2-ol 206115-88-0 1,202 15.481 1,208 -6 88 6.229 1,210 -8 89 -2 -1

Acetic acid, octyl ester 112-14-1 1,210 15.648 1,212 -2 92 6.285 1,213 -3 89 -1 3

Benzofuran, 2-ethenyl- 7522-79-4 1,220 15.994 1,220 0 89 6.428 1,221 -1 86 -1 4

2,6-Octadien-1-ol, 3,7-dimethyl-, (Z)- 106-25-2 1,228 16.337 1,228 0 97 6.577 1,230 -2 98 -2 0

Neral 106-26-3 1,240 16.860 1,241 -1 90 6.776 1,242 -2 88 -1 2

Carvone 99-49-0 1,242 16.966 1,243 -1 87 6.821 1,245 -3 86 -2 2

Linalyl acetate 115-95-7 1,257 17.587 1,258 -1 95 7.079 1,260 -3 92 -2 3

Citral 5392-40-5 1,273 18.124 1,270 3 93 7.283 1,272 1 89 -2 4

Table 4. Analysis results for neroli oil with both the helium and hydrogen methods. (LR = low response; Int = interference.)
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Compound Name CAS Lib RI

Helium Hydrogen with Hydroinert RI He- 
RI H2

LMS He-
LMS H2RT RI Delta RI LMS RT RI Delta RI LMS

2,6-Octadien-1-ol, 3,7-dimethyl-, formate, (Z)- 2142-94-1 1,282 18.575 1,281 1 89 7.452 1,282 0 89 -1 0

Levo-bornyl acetate 5655-61-8 1,285 18.780 1,286 -1 99 7.534 1,287 -2 95 -1 4

Indole 120-72-9 1,294 18.998 1,291 3 99 7.637 1,293 1 99 -2 0

Benzene, (2-nitroethyl)- 6125-24-2 1,302 19.280 1,298 4 89 7.746 1,299 3 86 -1 3

Geranyl formate 105-86-2 1,300 19.483 1,303 -3 91 7.811 1,303 -3 91 0 1

δ-EIemene 20307-84-0 1,338 20.958 1,338 0 86 8.392 1,338 0 96 0 -10

Methyl anthranilate 134-20-3 1,343 21.020 1,339 4 94 8.439 1,341 2 98 -2 -4

alpha-Terpinyl acetate 80-26-2 1,350 21.445 1,349 1 97 8.593 1,350 0 96 -1 2

6-Octen-1-ol, 3,7-dimethyl-, acetate 150-84-5 1,354 21.647 1,354 0 84 8.669 1,354 0 81 0 2

2,6-Octadien-1-ol, 3,7-dimethyl-, acetate, (Z)- 141-12-8 1,364 22.133 1,366 -2 99 8.881 1,367 -3 99 -1 0

Copaene 3856-25-5 1,376 22.543 1,375 1 82 9.026 1,376 0 80 -1 2

Geranyl acetate 105-87-3 1,382 22.966 1,385 -3 98 9.222 1,387 -5 98 -2 0

levo-β-Elemene 515-13-9 1,391 23.236 1,392 -1 96 9.307 1,393 -2 95 -1 1

Benzoic acid, 2-amino-, ethyl ester 87-25-2 1,414 24.091 1,413 1 86 9.662 1,414 0 93 -1 -7

Caryophyllene 87-44-5 1,419 24.340 1,419 0 99 9.751 1,420 -1 99 -1 0

gamma-Elemene 29873-99-2 1,434 24.921 1,433 1 83 9.977 1,434 0 88 -1 -6

Humulene 6753-98-6 1,454 25.707 1,453 1 92 10.293 1,453 1 91 0 1

(E)-beta-Farnesene 18794-84-8 1,457 25.894 1,457 0 96 10.363 1,458 -1 96 -1 0

Alloaromadendrene 25246-27-9 1,461 26.002 1,460 1 92 10.408 1,460 1 84 0 8

gamma-Muurolene 30021-74-0 1,477 26.657 1,476 1 93 10.669 1,476 1 91 0 2

Germacrene D 23986-74-5 1,481 26.824 1,480 1 95 10.736 1,481 0 97 -1 -2

Bicyclogermacrene 24703-35-3 1,496 27.445 1,496 0 98 10.985 1,496 0 97 0 1

alpha-Muurolene 10208-80-7 1,499 27.605 1,500 -1 96 11.048 1,500 -1 93 0 3

alpha-Farnesene 502-61-4 1,508 27.955 1,509 -1 94 11.186 1,509 -1 96 0 -1

γ-Cadinene 39029-41-9 1,513 28.137 1,513 0 97 11.261 1,514 -1 96 -1 1

δ-Cadinene 483-76-1 1,524 28.519 1,523 1 97 11.413 1,524 0 97 -1 1

α-Cadinene 24406-05-1 1,538 29.047 1,537 1 80 11.626 1,537 1 81 0 -2

alpha-Calacorene 21391-99-1 1,542 29.254 1,542 0 94 11.710 1,543 -1 82 -1 13 LR

β-Germacrene 15423-57-1 1,557 29.779 1,556 1 96 11.915 1,556 1 87 0 10 Int

1,6,10-Dodecatrien-3-ol, 3,7,11-trimethyl- 7212-44-4 1,564 30.146 1,565 -1 97 12.091 1,567 -3 97 -2 0

Spathulenol 6750-60-3 1,576 30.574 1,576 0 93 12.244 1,577 -1 85 -1 9

Caryophyllene oxide 1139-30-6 1,581 30.788 1,582 -1 92 12.329 1,583 -2 90 -1 2

tau-Cadinol 5937-11-1 1,640 32.985 1,641 -1 96 13.198 1,641 -1 95 0 2

δ-Cadinol 19435-97-3 1,645 33.163 1,646 -1 92 13.276 1,646 -1 88 0 4

alpha-Cadinol 481-34-5 1,653 33.462 1,654 -1 96 13.396 1,654 -1 94 0 2

Naphthalene, 1,6-dimethyl-4-(1-methylethyl)- 483-78-3 1,674 34.205 1,675 -1 92 13.695 1,674 0 78 1 14 LR, Int

8-Heptadecene 2579-04-6 1,677 34.320 1,678 -1 95 13.731 1,677 0 94 1 2

6,10-Dodecadien-1-ol, 3,7,11-trimethyl- 51411-24-6 1,692 34.795 1,691 1 81 13.928 1,690 2 87 1 -6

2,6,10-Dodecatrien-1-ol, 3,7,11-trimethyl-, (Z,E)- 3790-71-4 1,697 35.110 1,700 -3 92 14.058 1,699 -2 89 1 3

trans-Farnesol 106-28-5 1,722 35.968 1,724 -2 97 14.418 1,724 -2 98 0 -1

Farnesol, 2E, 6Z- 3879-60-5 1,742 36.652 1,743 -1 79 14.676 1,743 -1 78 0 1

all-trans-Farnesyl acetate 4128-17-0 1,843 40.112 1,842 1 94 16.057 1,843 0 92 -1 3

Cubitene 66723-19-1 1,878 41.166 1,874 4 82 16.479 1,874 4 78 0 3

m-Camphorene 20016-73-3 1,960 43.728 1,952 8 95 17.508 1,953 7 93 -1 3

p-Camphorene 20016-72-2 1,995 44.815 1,986 9 92 17.942 1,986 9 91 0 1

Hexadecanoic acid, ethyl ester 628-97-7 1,993 45.083 1,995 -2 73 18.054 1,995 -2 75 0 -2
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Conclusion
Using the techniques described in this application note, a 
typical method for the qualitative analysis of essential oils 
was successfully converted to a method using hydrogen 
carrier gas. The resulting hydrogen method retains the same 
chromatographic resolution and relative elution order of the 
original method, but with a run time 2.5 times shorter. The 
column capacity with the new method is reduced, being a 
calculated 36% of the original method, so the amount injected 
may need adjustment in some cases.

The new hydrogen method was then applied to the 
analysis of two essential oils and found to generate results 
comparable to those from the helium method. The use of 
spectral deconvolution and retention index search filtering 
with Agilent MassHunter Unknowns Analysis gave improved 
search results that were faster than previous identification 
methods. The NIST23 library, with expanded content for 
essential oil components and RIs, allowed identification of a 
significant portion of the compounds present.

The Agilent HydroInert source is a key component in the 
successful conversion to hydrogen. Without it, in-source 
reactions were shown to degrade the spectra of some 
compounds to the point where they were misidentified.
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Appendix

Setting up MassHunter Unknowns Analysis
This section shows how to set up Agilent MassHunter 
Unknowns Analysis. The parameters shown here were used 
in this specific application. For other applications, different 
parameters can be used to optimize the process.

Locate the Agilent MassHunter Quantitative Analysis software 
folder under the Microsoft Windows Start menu and open the 
MassHunter Unknowns Analysis program.

1.	 Click File > New Analysis. Navigate to the directory 
containing your data files.

2.	 Enter a file name for the analysis.

3.	 Click File > Add Samples. Select the data files that 
you want to process. You should see the TIC of your 
chromatogram appear.

4.	 Click Method > Edit. Set the parameters as shown in 
Appendix Figures 1 to 5. 

Leave these 
at defaults

Leave these at defaults

Set these

Appendix Figure 1. Setting the parameters for the Peak Detection and Deconvolution tabs in Agilent MassHunter Unknowns Analysis.
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Leave these 
at defaults

Set these values

Select NIST23.L

Select the .rtc file created in Notepad

Appendix Figure 2. Setting the parameters for the Library Search tab in 
Agilent MassHunter Unknowns Analysis.

Leave these 
at defaults
for now

Set to 70

Appendix Figure 3. Setting the parameters for the Compound Identification 
tab in Agilent MassHunter Unknowns Analysis.

Leave everything at defaults

Appendix Figure 4. Setting the parameters for the Target Match tab in 
Agilent MassHunter Unknowns Analysis.

Leave these at defaults for now

Select Apply to Selected Sample, then Close. 

After closing, go to the Analyze menu and select Analyze Sample. 
Note: it will take a while to process.

Uncheck this

Appendix Figure 5. Setting the parameters for the Blank Subtraction tab in 
Agilent MassHunter Unknowns Analysis.
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Appendix Figure 6. Example result of a deconvoluted/searched data file in Agilent MassHunter Unknowns Analysis.

Right-click the title bar and select Add/Remove Columns. 
Select these columns for now.

Library spectrum

More examples of in-source reactions eliminated with 
the HydroInert source
In this section, the spectra of several compounds from 
the Brazilian orange and neroli oils are examined. For each 
compound, the spectrum obtained using helium and the 
3 mm inert extractor source is presented with the spectrum 
for each compound obtained using hydrogen with the 9 mm 
HydroInert source, and the inert extractor source with the 
9 and 3 mm extractor lenses. As shown in Figures 7 to 11, 
changes in the hydrogen spectra without the HydroInert 
source are clear, resulting in reduced LMS values and reduced 
confidence in identification.
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Appendix Figure 7. Linalool in Brazilian orange oil. Red arrows indicate spectral changes observed with hydrogen carrier and non-HydroInert sources.
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Appendix Figure 8. cis-Carveol in Brazilian orange oil. Red arrows indicate spectral changes observed with hydrogen carrier and non-HydroInert sources.
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Appendix Figure 9. trans-Carveol in Brazilian orange oil. Red arrows indicate spectral changes observed with hydrogen carrier and non-HydroInert sources.
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Appendix Figure 10. p-Cymen-8-ol in neroli oil. Red arrows indicate spectral changes observed with hydrogen carrier and non-HydroInert sources.
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Appendix Figure 11. (3E,5E)-2,6-Dimethylocta-3,5,7-trien-2-ol in neroli oil. Red arrows indicate spectral changes observed with hydrogen carrier and 
non‑HydroInert sources.
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Neroli oil: (3E,5E)-2,6-Dimethylocta-3,5,7-trien-2-ol (CAS 206115-88-0)
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